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Предисловие 

 

В программе подготовки географов на географическом факультете МГУ имени 

М. В. Ломоносова особое внимание уделяется методам полевых исследований как специальным, 

связанным с изучением отдельных компонентов ландшафта, так и универсальным, которые 

студенту-географу нужно освоить независимо от его специализации. К последним относится 

наземная цифровая фотосъёмка, без которой сейчас не обходится ни одна экспедиция.  

За время обучения студенты должны не только освоить основы цифровой фотографии, но и 

получить практические навыки фотосъёмки природных объектов, научиться планировать съёмку в 

соответствии с особенностями исследуемого объекта: намечать цель и предполагаемые 

результаты, подбирать подходящий вид фотосъёмки, соответствующую аппаратуру и 

последовательность выполняемых работ. Они должны научиться осмысленно подходить к выбору 

точки съёмки, границ и композиции кадра, ориентированию фотоаппарата в момент съёмки,  

выбору установок фотоаппарата и условий освещения объекта, должны ориентироваться в 

различных видах съёмки и возможностях их применения при полевых географических 

исследованиях объектов различных типов. 

В учебном пособии «Цифровая фотография для студентов – географов. Практические работы» 

приведены примеры заданий, которые помогут студентам познакомиться с наиболее 

востребованными в полевых географических исследованиях видами фотосъёмки, освоить на 

практике технических приёмы этих съёмок. Задания содержат описание всего цикла работ, 

начиная с планирования полевого этапа и заканчивая компьютерной обработкой полученных 

цифровых снимков, включают пошаговые инструкции выполнения работ.  

Пособие предназначено для выполнения практических работ во время полевой 

общегеографической практики студентов, может быть использовано для самостоятельного 

освоения панорамной, стереоскопической фотосъёмки и фотосъёмки с близкого расстояния или 

макросъёмки.  

Пособие разработано в лаборатории аэрокосмических методов кафедры картографии и 

геоинформатики географического факультета МГУ имени М. В. Ломоносова и основано на 

обобщении опыта работы факультативного практикума по цифровой фотографии. Занятия 

практикума, организованного по инициативе заведующего лабораторией аэрокосмических 

методов Ю. Ф. Книжникова и при поддержке декана (до 2015 года), а ныне президента 

географического факультета Н. С. Касимова, проводятся более десяти лет на общегеографической 

практике студентов первого курса на учебно-научном полигоне «Сатино». В первые годы 
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подготовка и проведение занятий выполнялись В. В. Вальковой, с 2008 г. – О. В. Вахниной и 

С. Г. Нечелюстовым. В пособии использованы фотоснимки О. В. Вахниной, С. Г. Нечелюстова и 

студентов географического факультета, проходивших практику в период с 2008 по 2014 гг. 

О. В. Вахнина является автором предисловия, практических работ 1–3; С. Г. Нечелюстов – 1; 

Е. Г. Харьковец – практической работы 2; Е. Р. Чалова – практической работы 1. Редактирование и 

подготовку рукописи к изданию выполнили Е. Р. Чалова и О. В. Вахнина. 

Авторы пособия благодарят рецензентов работы, всех сотрудников лаборатории 

аэрокосмических методов за ценные замечания и советы, позволившие улучшить содержание 

пособия. Особую благодарность авторы выражают Ю. Ф. Книжникову, по инициативе и при 

содействии которого создавалось это пособие. 
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1. Панорамная фотосъёмка 

 

Цель работы 

Знакомство с различными способами получения панорамных снимков. Освоение панорамной 

фотосъёмки с использованием цифровых камер любительского класса на примере фотосъёмки 

долины реки. Освоение компьютерного монтажа фотопанорамы из серии снимков. 

Назначение панорамной фотосъёмки. Возможные области применения в географии 

Основное назначение панорамной фотосъёмки – получение изображений объектов, 

занимающих значительную территорию. Обычная покадровая съёмка широкоугольным 

объективом не позволяет запечатлеть такие объекты без потери важных деталей. В этом случае 

применяют различные виды панорамной съёмки, которые позволяют получать снимки с широким 

углом обзора (до 180 и более градусов). В зависимости от ориентации и размеров объекта, 

который необходимо отобразить, получают горизонтальные, вертикальные, многоярусные, 

круговые панорамы, вплоть до сферических, создающих эффект присутствия в центре снимаемого 

ландшафта. 

Необходимость в панорамной съёмке часто возникает при ландшафтных, гидрологических, 

геоботанических, метеорологических и других исследованиях, например при обследовании 

долины реки или изучении облачных систем. Панорамные снимки могут использоваться в 

качестве обзорных снимков, отображающих географическое положение изучаемого объекта как 

части природного комплекса более высокого ранга. На полевой общегеографической практике 

первого курса панорамная фотосъёмка входит в список рекомендуемых для всех видов практик. 

Используемое оборудование 

На разных этапах развития фотосъёмки для получения панорамных снимков использовались 

или используются и сейчас специальные панорамные фотоаппараты, панорамные насадки, 

сверхширокоугольные объективы типа «рыбий глаз», обычные цифровые фотоаппараты. 

Специальные панорамные фотоаппараты, как плёночные, так и цифровые, имеют схожие 

конструктивные особенности. Объектив в подобных фотоаппаратах во время экспозиции 

поворачивается вокруг главной точки синхронно с движением шторно-щелевого затвора, что и 

позволяет получать широкоформатный кадр с углом охвата до 120–140°. Из-за высокой стоимости 

панорамные фотоаппараты не получили широкого распространения. 

Сверхширокоугольные объективы типа «рыбий глаз» – с фокусным расстоянием порядка 10 мм  

и углом поля зрения около 180° – позволяют одним кадром охватить пространство в рамках 

полусферы, однако изображения, полученные такими объективами, имеют существенные 

геометрические искажения. 
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Самым распространённым способом получения панорамных снимков является съёмка обычным 

цифровым фотоаппаратом любительского класса. Такой способ предполагает получение с одной 

точки серии перекрывающихся снимков и их последующее соединение в панораму в 

компьютерных программах. На использование фотоаппаратов любительского класса рассчитана и 

данная практическая работа. 

Для получения панорамных снимков высокого качества рекомендуется использовать 

дополнительное оборудование: штативы с горизонтальным уровнем и специальные панорамные 

головки, которые обеспечивают вращение фотоаппарата не вокруг гнезда штативного соединения, 

а вокруг главной точки объектива. Особенно важно использование панорамной головки при 

съёмке сферических панорам, когда возникает необходимость поворачивать камеру на 

фиксированные углы не только в горизонтальной плоскости, но и наклонять фотоаппарат вверх и 

вниз (до 90°
 
относительно горизонта) для съемки панорамы в несколько рядов. 

При выполнении практической работы предполагается получение панорамных снимков с рук и 

с использованием штатива с пузырьковыми уровнями. 

Теоретическое обоснование 

При панорамной съёмке обычным цифровым фотоаппаратом один снимок протяжённого 

объекта, полученный объективом с коротким фокусным расстоянием (с большим углом поля 

зрения) и, следовательно, с большими геометрическими искажениями, заменяется на несколько 

снимков этого же объекта, полученных с одной точки съёмки объективом с большим фокусным 

расстоянием (меньшим углом зрения) и значительно меньшими геометрическими искажениями. В 

дальнейшем серия снимков, полученных с перекрытием, после предварительной компьютерной 

обработки соединяется в один панорамный снимок, спроецированный на выбранный тип 

поверхности (плоскость, цилиндр или сферу). В итоге получают изображение в виде одного кадра, 

который с необходимой детальностью и обзорностью отображает протяжённый объект (рис. 1.1).  

Чтобы получить панораму 

хорошего качества, на которой не 

искажены пропорции объектов и 

не заметны границы кадров, 

следует обеспечить наилучшую 

совместимость соседних кадров 

по геометрии изображения и по 

цветопередаче. Это можно 

сделать, если придерживаться 

определённых правил съемки. 

 
Рис. 1.1. Принципиальная схема панорамной съёмки 
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Выбор параметров и правила выполнения панорамной съёмки 

Выбор точки съёмки. Для достижения наименьших геометрических искажений и наилучшей 

совместимости соседние снимки должны иметь близкий масштаб изображения. Для этого съёмку 

следует выполнять при одном значении фокусного расстояния, а точку съёмки расположить по 

возможности на одинаковом расстоянии от снимаемых объектов. 

Выбор границ и композиции панорамы. В случае сферической и круговой панорам вопрос о 

выборе ее границ не стоит. При планировании панорамы с меньшим углом обзора важно перед 

съёмкой наметить границы первого и последнего кадров. Если съёмка выполняется в научных 

целях, желательно, чтобы в центре панорамы оказался объект, представляющий наибольший 

интерес. Чтобы получить художественно привлекательную панораму, например для оценки  

эстетических качеств ландшафта, особое внимание следует обратить на композицию панорамы, 

распределение центров притяжения взгляда, соотношение объектов среднего и дальнего планов. 

Ориентирование камеры. В процессе создания панорамы производится трансформирование 

соседних кадров. На качество трансформирования помимо различий в масштабе снимков влияет 

разница в углах наклона и разворота камеры в момент съёмки. Чтобы свести к минимуму 

искажения за счёт углов наклона и разворота, желательно установить фотоаппарат на штатив, 

оборудованный пузырьковыми уровнями, и следить за тем, чтобы оптическая ось объектива была 

расположена горизонтально или под одним и тем же углом к линии горизонта. 

Выбор фокусного расстояния. Чем больше фокусное расстояние объектива, тем меньше 

перспективные искажения по краям снимков и тем лучше будут совмещены соседние кадры 

панорамы при её монтаже. Рекомендуется выбирать по возможности большее фокусное 

расстояние, но с учётом того, чтобы в кадр помещались все объекты съёмки. 

Перекрытие соседних кадров. Совмещение соседних кадров при компьютерной обработке 

выполняется по соответственным точкам – чётко опознающимся деталям одних и тех же объектов, 

изобразившихся в областях перекрытия снимков, которые должны быть не менее 15–20%. 

Обеспечивают такое перекрытие, пользуясь, например, сеткой вспомогательных линий на экране 

ЖК монитора фотоаппарата. Другой эффективный способ – использование панорамного режима 

съёмки, предусмотренного в некоторых камерах. В этом режиме начиная со второго кадра 

панорамы на экране монитора помимо текущего отображается и часть предыдущего кадра. Слегка 

перемещая фотоаппарат, можно совместить изображения обоих кадров и тем самым не только 

обеспечить нужное перекрытие снимков, но и свести к минимуму ошибки ориентирования камеры 

за счёт разницы в углах её наклона и разворота. В других цифровых камерах монтаж панорам 

может выполняться её собственным микропроцессором во время самой съёмки, что с одной 

стороны упрощает процесс получения панорамы, а с другой – ограничивает возможность влияния 

на качество результата. 
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Ориентация кадра. Поскольку геометрические искажения возрастают при увеличении 

расстояния от центра снимка, для улучшения качества панорамы горизонтальную панораму лучше 

снимать, установив фотоаппарат вертикально, а вертикальную – наоборот, камерой, закрепленной 

горизонтально. В панорамном режиме съёмка выполняется на горизонтальный кадр. 

Выбор условий освещения. Чтобы смонтированное изображение панорамы воспринималось как 

единый снимок, соседние кадры должны иметь схожие цветовые и контрастные характеристики. 

Поэтому особое значение придается выбору условий освещения. Они должны быть благоприятны 

для съёмки панорамы в целом и не слишком различаться в разных частях снимаемого объекта. 

Наилучшие условия наблюдаются при полностью безоблачной погоде, либо при рассеянном 

освещении, создаваемом сплошной облачностью. Рассеянное освещение особенно благоприятно 

для съёмки круговых панорам, так как оно не создаёт больших различий в освещенности объектов, 

по разные стороны от точки съёмки. При съёмке панорамы с меньшим углом обзора Солнце 

должно светить из-за спины фотографа, чтобы обеспечить примерно одинаковые условия 

освещения объектов в центре и по краям панорамы. В любом случае солнечные лучи не должны 

попадать в объектив фотоаппарата. 

Не рекомендуется снимать панораму при переменной облачности в условиях ветреной погоды. 

На полученных в такую погоду соседних снимках по-разному отобразятся тени от быстро 

перемещающихся облаков, изображение будет существенно различаться по уровню яркости и 

цветовой гамме, что приведёт к полосчатости смонтированной панорамы. 

Для обеспечения одних и тех же условий съёмки всех кадров панорамы очень важно правильно 

выбрать настройки фотоаппарата (чувствительность матрицы, баланс белого, диафрагму и 

выдержку). Настройки выбирают по «ключевому кадру» – участку панорамы, отличающемуся 

средними для всей панорамы условиями освещения. Если точка съёмки выбрана правильно, чаще 

всего в качестве «ключевого кадра» выступает центральная часть панорамы. Менять настройки 

фотоаппарата во время съёмки всей серии снимков нельзя. 

Соблюдение перечисленных правил позволит получить качественные снимки для последующей 

компьютерной обработки и  монтажа панорамного снимка. 

Компьютерная обработка снимков. Программное обеспечение  

Если панорама создаётся из серии снимков, конечной целью компьютерной обработки является 

соединение их в один кадр панорамы так, чтобы на нём не были заметны границы соседних 

снимков. В компьютерной обработке можно условно выделить несколько моментов: поиск 

соответственных точек для взаимного ориентирования снимков, устранение геометрических 

искажений, проецирование на выбранный тип поверхности, яркостная и цветовая коррекция 

снимка (рис. 1.2). 
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Рис. 1.2. Компьютерная обработка при создании панорамы из серии 

перекрывающихся снимков 
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Компьютерная обработка может быть выполнена в программе Adobe Photoshop 

(File→Automate→Photomerge) или в специальных программах автоматического создания панорам. 

Такие программы имеют простой и удобный интерфейс, позволяющий настроить все 

необходимые параметры создания панорам. Некоторые из них, например бесплатные программы, 

прилагающиеся к фотоаппаратам фирм Canon (Photo Stitch), программа Image Composite Editor 

фирмы Microsoft и другие, ориентированы на широкого пользователя, содержат минимум 

элементов управления и призваны максимально упростить процесс создания панорам. Другие, 

например Panorama Factory или PTGui, обладают более сложным интерфейсом, но предоставляют 

больше возможностей и обеспечивают лучший результат.  

Процесс монтажа панорамы включает нескольких ключевых моментов. 

На первом этапе предусматривается внесение исходных данных об использованной 

фотоаппаратуре, типе создающейся панорамы (вертикальная или горизонтальная, круговая и т.д.) 

и настройках фотоаппарата (прежде всего о величине фокусного расстояния камеры). Эти данные 

требуются для исправления перспективных искажений снимков, которые необходимо учитывать 

при трансформировании и совмещении соседних кадров. Как правило, такие данные 

автоматически считываются программой из EXIF-информации, но их можно ввести и вручную, 

например, если используются не оригинальные, а отсканированные фотографии. 

Важный момент – поиск соответственных точек в областях перекрытия соседних кадров. В 

автоматическом режиме, иногда с возможностью ручной коррекции, программа находит на 

снимках одинаковые точки, которые используются как опорные для взаимного ориентирования 

снимков. Трансформированные снимки проецируются на выбранный тип поверхности. В 

зависимости от угла охвата и типа панорамы (одноярусная, многоярусная, круговая или 

сферическая) это может быть плоскость, цилиндр или сфера. Одновременно исправляются 

искажения за счет разницы в углах наклона и разворота камеры и корректируются перспективные 

искажения, возникающие из-за разницы в расстояниях от точки съёмки до объектов в центре и на 

краях панорамы. 

Затем на основе анализа гистограмм распределения яркостей выполняется выравнивание 

контрастов и цветовой гаммы соседних кадров, так, чтобы не были заметны их границы. Его 

задача – обеспечить целостное восприятие панорамы как единого снимка. На заключительном 

этапе выполняется кадрирование полотна панорамы, обрезка его краев. 

Полученные панорамные снимки могут быть сохранены в виде файлов в растровых форматах и 

отпечатаны на бумаге. Сферические панорамы предназначены для демонстрации на экране 

монитора в специальных программах.  

 

 



 12 

Порядок выполнения практической работы 

В данной работе предусмотрено получение двух панорам одного объекта при различных 

значениях параметров съёмки (фокусного расстояния объектива и ориентации кадра). 

Подготовительный этап. Планирование съёмки 

На этапе планирования следует выполнить рекогносцировку местности, выбрать точку и время 

фотосъёмки. Предварительное заключение можно сделать на основе анализа имеющихся карт и 

внести в него коррективы перед началом съёмки в поле: 

1. выбрать объект панорамной съёмки – протяжённый участок склона долины и поймы реки и 

точку съёмки на противоположном берегу реки; 

2. выбрать время (час) съёмки, при котором освещение снимаемого объекта будет 

оптимальным – фронтальным или задним боковым. 

Полевой этап. Получение серии снимков для создания панорамы 

На протяжении полевого этапа после окончательного выбора точки съёмки следует наметить 

границы горизонтальной панорамы и выполнить фотосъёмку. 

1. В намеченное время занять выбранную для съёмки позицию. Уточнить границы панорамы 

и положение точки съёмки так, чтобы она находилась примерно на одном расстоянии от границ  

снимаемого участка. 

2. Если используется штатив, установить и выровнять его по пузырьковому уровню, 

закрепить на нём фотоаппарат. 

3. Правильно сориентировать фотоаппарат. При съёмке в обычном режиме горизонтальную 

панораму рекомендуется снимать на вертикально ориентированный кадр, при использовании 

панорамного режима – на горизонтальный кадр. 

4. Установить фокусное расстояние, соответствующее «нормальным» объективам с углом 

поля зрения около 50° (в случае использования объектива с переменным фокусным расстоянием – 

среднее значение для данного объектива). По участку, соответствующему «ключевому кадру», 

выбрать значения основных настроек фотоаппарата и зафиксировать их. Если в камере не 

предусмотрена функция экспозиции (AE Lock), можно перейти в ручной режим управления 

параметрами. В панорамном режиме фиксация параметров выполняется автоматически. 

5. Выполнить пробный просмотр выбранного для панорамы участка долины через 

видоискатель или жидкокристаллический экран. При съемке горизонтальной панорамы просмотр, 

как и съёмку, рекомендуется выполнять слева направо (по часовой стреле). Проверить, чтобы все 

сюжетно важные объекты попали в кадр, а движение объектива строго следовало линии 

горизонта. Убедиться, что в кадр не попадают случайные объекты ближнего плана. 

6. Выполнить съёмку серии снимков в обычном или панорамном режиме. При съёмке в 

обычном режиме для контроля перекрытия соседних кадров использовать вспомогательную сетку 
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на ЖК мониторе, при съёмке в панорамном режиме – совмещение изображений текущего кадра с 

выводимой на экран частью предыдущего кадра. 

7. Закончив съёмку последнего кадра панорамы, приступить к съёмке этого же объекта с 

другими параметрами съёмки. Не меняя позицию, увеличить  фокусное расстояние объектива, 

чтобы снимаемые объекты панорамы были максимально приближены, но при этом самые важные 

из них не остались за кадром. Поменять ориентацию кадра с горизонтальной на вертикальную. 

Выполнить съёмку в пределах намеченных ранее границ с новыми установками. 

Камеральный этап 

В работе предусмотрено получение панорам средствами программы Photo Stitch или Adobe 

Photoshop. 

Порядок выполнения работы в программе Photo Stitch (программное приложение к 

фотоаппаратам фирмы Canon) 

1. Открыть программу создания панорам Photo Stitch. При запуске программы выбрать 

вариант Merge Images. 

2. Загрузить серию снимков для монтажа панорамы. Для этого в первой вкладке «Selection and 

Arrangement» выбрать «Open» и найти папку, содержащую отснятые на занятии снимки. Имена 

снимков, полученных в обычном режиме имеют вид IMG_0001, IMG_0002 и т. д. Снимки, 

полученные в панорамном режиме могут иметь специфические имена, которые присвоены им 

камерой. Они отражают принадлежность к той или иной панораме. 

Например, снимки первой по счёту панорамы, полученные в панорамном режиме камерой  

Canon J9 будут иметь следующие имена 

STA_0001, STB_0002, STC_0003. 

ST в имени обозначает, что съёмка велась в панорамном режиме; 

A, B, C – порядковый номер кадра в этой серии; 

0001, 0002, 0003 – сквозные номера всех кадров, снятых в панорамном режиме и хранящихся в 

данный момент на карте памяти камеры. 

Снимки второй по счёту снятой панорамной серии из четырёх кадров будут иметь имена 

STA_0004, STB_0005, STC_0006, STD_0007 и т. д. 

3. Загрузив снимки, относящиеся к первой панораме, кнопкой «Arrange» выбрать из 

имеющихся вариантов тип панорамы (вертикальная, горизонтальная, многоярусная или круговая).  

4. Убедиться, что снимки располагаются по порядку слева направо. При необходимости 

исправить порядок расположения (кнопка «Switch»),  удалить лишние кадры (кнопка «Clear») или 

развернуть их (кнопка «Rotate»). 

5. Перейти на вторую вкладку «Merge», которая запускает монтаж панорамы кнопкой «Start». 

После вывода на экран панорамы нажать кнопку «Hide Seams». На экране прямоугольными 
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рамками выделятся области стыковки соседних кадров. Если результат  автоматической стыковки 

не устраивает, исправить ситуацию, обозначив соответственные точки, необходимые для 

стыковки вручную. Для этого двойным щелчком левой кнопки мышки в области перекрытия 

открыть окно «Amend Merge Results» и, следуя подсказкам, выполнить одним из предложенных  

способов совмещение кадров вручную. 

6. Перейти на вкладку «Save». Будет запущен процесс, по окончании которого на экран будет 

выведена панорама, на которой прямоугольной рамкой выделены границы кадра. При 

необходимости отредактировать кадрирование вручную, после чего сохранить панораму. 

7. Дождавшись сохранения панорамы, согласиться с предложением просмотреть результат. 

Оценить качество панорамы, просмотрев в крупном масштабе места стыковки соседних кадров. 

Закончив монтаж первой панорамы, перейти к обработке снимков второй панорамы, 

полученной с большим фокусным расстоянием. 

Порядок выполнения работы в программе Adobe Photoshop 

1. Открыть кадры панорамной съёмки. 

2. Активировать модуль монтажа панорамы File →Automate→Photomerge. 

3. Выбрать в меню открывшегося окна пункт Add Open Files. 

4. Выбрать автоматический режим создания панорамы, учитывающий поверхность, на 

которую будет проектироваться панорама, предполагаемый характер искажений на исходных 

снимках и способ совмещения соседних кадров (Auto, Perspective, Cylindrical, Reposition Only). 

Программа выполнит монтаж панорамы, автоматически приведя снимки к одному масштабу и 

устранив перспективные искажения. При желании выбрать ручной режим совмещения кадров 

(Interactive Layout). 

Подготовка снимков к отчёту 

Для подготовки снимков к отчёту в программе Adobe Photoshop создать новый документ А4 и 

перенести в него изображения двух панорам, полученных при разных условиях съёмки. Для 

каждой панорамы указать фокусное расстояние объектива, при котором выполнялась съёмка 

(рис. 1.3). 

Контрольные вопросы 

1. Назовите типы фотоаппаратов (объективов), дополнительное оборудование, необходимое 

для получения панорамных снимков. 

2. Перечислите основные правила ориентирования фотокамеры при съёмке серии снимков, 

предназначенных для создания панорамы. 

3. Какие погодные условия нежелательны для съёмки панорам? 

4. Каким должно быть перекрытие соседних кадров?  Не менее …….% 
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5. Можно ли менять установки фотоаппарата при съёмке серии снимков для создания 

панорам? 

6. Перечислите основные виды преобразований цифровых снимков при компьютерном 

создании панорам. 

Отчётный материал 

1. Две серии снимков для создания панорамы, полученные  при разных значениях установок 

фотоаппарата. 

2. Два цифровых панорамных снимка, полученных в результате компьютерного монтажа в 

программах Adobe Photoshop или Photo Stitch.  

3. Распечатка панорамных снимков, оформленных в соответствии с образцом. 

4. Ответы на контрольные вопросы. 

 

 

 

 

 

Рис. 1.3. Пример оформление отчётного материала 
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 2. Наземная стереоскопическая фотосъёмка для визуального 

стереонаблюдения 

 

Цель работы 

Освоение наземной стереоскопической фотосъёмки цифровыми фотоаппаратами 

любительского класса на примере стереофотосъёмки форм рельефа. Знакомство со способами 

компьютерной обработки стереопары цифровых снимков, предназначенных для визуального 

стереонаблюдения. Освоение способов получения анаглифических снимков. 

Назначение стереоскопической фотосъёмки. Возможные области применения в географии 

Назначение стереоскопической фотосъёмки – получение снимков для создания 

стереоскопической (объёмной) модели объекта. Стереоскопическую модель используют как для 

точных измерений, в результате которых получают цифровые модели рельефа или отдельные 

морфометрические характеристики объектов, так и для визуального анализа с целью 

дешифрирования и качественной оценки состояния объектов. В зависимости от задач и масштаба 

исследования стереосъёмку выполняют из космоса, с самолёта или в наземных условиях. 

Наземная стереоскопическая фотосъёмка в полевых географических исследованиях чаще 

всего используется для изучения форм рельефа и природных процессов, которые проявляются в 

изменении поверхности объекта, например в результате различных склоновых, русловых 

процессов, таяния ледников и т. д. Стереоскопическая съёмка может использоваться для оценки 

эстетического восприятия ландшафтов, для обследования и наглядного представления объектов 

туризма, других природных и антропогенных объектов. Выполнение этого вида съёмки 

рекомендуется, прежде всего, во время прохождения практики по топографии, геоморфологии и 

ландшафтоведению. 

Используемое оборудование 

Если в ходе наземной стереоскопической фотосъёмки планируется получение снимков, 

предназначенных для точных стереоскопических измерений, съёмка выполняется 

фототеодолитами – специальными фотокамерами, оснащёнными высокоточными 

ориентирующими устройствами. Фототеодолитная съёмка ведётся с устойчивых геодезических 

штативов и предусматривает дополнительные геодезические измерения для определения 

координат точек съёмки. 

Если задача точных измерений, как в данной работе, не ставится, стереоскопическая 

фотосъёмка может выполняться для визуального бинокулярного наблюдения стереоскопической 

модели. В этом случае съёмку можно выполнять фотоаппаратами любительского класса: 

обычными однообъективными фотоаппаратами или фотоаппаратами, оснащёнными двумя 
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объективами, позволяющими делать два снимка одновременно. Двухобъективные фотоаппараты с 

функцией видеосъёмки или двухобъективные видеокамеры используют также для съёмки 

стереоскопических видеофильмов. В качестве дополнительного оборудования при 

стереоскопической фотосъёмке рекомендуется использовать фотоштатив. 

В данной работе предусмотрено использование цифрового фотоаппарата любительского класса 

и фотоштатива с пузырьковым уровнем. 

Теоретическое обоснование 

Возможность объёмного восприятия окружающего мира заложена в человеке от природы как 

дополнительное преимущество в борьбе за выживание. Объёмное, стереоскопическое, зрение 

позволило человеку определять относительное расстояние до объекта, например врага или 

потенциальной жертвы. Из геометрии известно, как вычислить расстояние, используя метод 

триангуляции. Подобная «триангуляция» выполняется в зрительном центре мозга человека на 

подсознательном уровне. Такая возможность связана с ориентацией глаз человека, которые 

располагаются в одной плоскости, на некотором расстоянии друг от друга – расстоянии глазного 

базиса (в среднем около 6 см). Благодаря этому человек наблюдает один и тот же объект левым и 

правым глазом под несколько различными углами. 

Если воспользоваться моделью стереозрения, разработанной природой, можно наблюдать такое 

же объёмное изображение, стереоскопическую модель, рассматривая не реальный объект, а два 

его снимка, полученные с двух точек съёмки. Одно изображение будет предназначаться для 

рассматривания только левым, другое – только правым глазом.  

Результатом стереофотосъёмки является стереопара – пара снимков одного и того же объекта, 

полученных с левой и правой точек съёмки. Расстояние на местности между левой и правой 

точками съёмки стереопары называется базисом стереосъёмки (В). В отличие от глазного базиса, 

длина базиса стереосъёмки может меняться в значительных пределах. 

 Изображения на снимках стереопары подобны, но не идентичны. Одни и те же точки объекта 

съёмки на левом и правом снимках, соответственные точки, смещены относительно центра 

снимков по оси х на определённое расстояние (рис. 2.1). Разность координат точек по оси х на 

левом и правом снимках называется продольным параллаксом: 

р = хл–хп  . 

Продольный параллакс точки прямо пропорционален фокусному расстоянию камеры f и длине 

базиса стереосъёмки и обратно пропорционален расстоянию от объектива фотоаппарата до этой 

точки (Y): 
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В отличие от продольного параллакса, 

возникновение поперечного параллакса 

крайне нежелательно. Поперечный 

параллакс, который определяется как 

разность координат точек на левом и правом 

снимках по оси y, свидетельствует о том, что 

во время съёмки в наземных условиях 

фотокамеры были смещены относительно 

друг друга по вертикали. Для наблюдения 

стереоскопической модели необходимо 

устранить поперечный параллакс, смещая 

друг относительно друга снимки стереопары. 

Если при рассматривании стереопары 

обеспечить раздельное наблюдение левого 

снимка только левым глазом, а правого – 

только правым, можно наблюдать 

уменьшенную стереоскопическую, то есть 

объёмную, модель объекта. Точки, по-

разному удалённые от линии базиса будут 

иметь различные значения продольного 

параллакса и, соответственно, 

восприниматься на разном отстоянии при 

наблюдении стереомодели. Разность 

продольных параллаксов двух точек рассчитывается как 

∆р = р1 – р2  . 

При малых значениях разности продольных параллаксов точек стереомодель будет выглядеть 

практически плоской. При слишком больших значениях ∆р становится невозможным наблюдение 

стереоскопической модели из-за трудности зрительного совмещения соответственных точек 

изображений объекта. Добиться нужных значений параллаксов, при которых восприятие 

стереоскопической модели будет оптимальным, можно, правильно выбрав фокусное расстояние 

объектива f, расстояние до снимаемых объектов Y и вычислив необходимое значение длины 

базиса стереосъёмки В. Расстояние Y до объектов съёмки (объектов ближнего, среднего и 

дальнего плана) влияет на выбор всех остальных параметров. При выборе фокусного расстояния, 

Рис. 2.1. Принципиальная схема стереофотосъёмки 

1 – точка на поверхности фотографируемого 

объекта, 1л ,  1п – изображения точки 1 на левом и 

правом снимках стереопары, В – базис 

стереосъемки, f – фокусное расстояние объектива, Y 

– расстояние до объекта,  p – продольный параллакс 

точки 1 



 19 

надо иметь в виду, что при прочих равных условиях большему значению f будут соответствовать 

и большие значения параллаксов. 

При зрительном восприятии пространства объекты воспринимаются стереоскопически от 

непосредственно близко расположенных до находящихся на некотором расстоянии, далее 

которого ощущение пространства связано лишь с восприятием перспективы. Соответственно, при 

стереосъёмке выделяются ближняя и дальняя границы стереоскопически передаваемого 

пространства и дальний план, уже не воспринимаемый стереоскопически. Стереопара обычно 

рассматривается с увеличением на экране монитора или в виде отпечатка. Поэтому при расчёте 

параметров стереосьёмки нужно учесть увеличение стереомодели и предельные значения 

параллаксов, обеспечивающих её стереоскопическое восприятие при заданном увеличении.   

Оптимальное расстояние рассмотрения увеличенного изображения находится в интервале от 25 см 

(для рассмотрения отпечатков на расстоянии наилучшего зрения) до 60–70 см и более (для 

рассмотрения на мониторе на безопасном для зрения расстоянии). Соответствующий таким 

расстояниям минимально допустимый параллакс (определяющий дальнюю границу 

стереоскопически передаваемого пространства), в зависимости от индивидуальных особенностей 

зрения, в среднем равен 1–3 мм, а максимальный (определяющий ближнюю границу) – 40–50 мм. 

Увеличение стереомодели определяется как отношение ширины рассматриваемого изображения 

W  к ширине исходного w , строящегося объективом на матрице. Естественным условием 

стереоскопического зрения является уверенное стереоскопическое восприятие близко 

расположенных объектов, поэтому при расчёте длины базиса стереосъёмки нужно стремиться к 

тому, чтобы параллакс близко расположенных объектов не выходил за пределы допустимых 

значений: 

f

Y

D

D

W

w
pB ближн

доп

0

  

где 
доп

p  – допустимое значение параллакса (мм), w– ширина матрицы фотоаппарата (мм),  W – 

ширина изображения при просмотре на экране монитора или отпечатке (мм), D – расстояние 

наблюдения стереомодели (мм), D
0
 – расстояние наилучшего зрения (250 мм), 

ближн
Y  – 

отстояние до ближайшей точки объекта съёмки (м), f – фокусное расстояние объектива (мм), B  – 

базис стереосъёмки (м). 

Для практического использования расчёт параметров стереосъёмки можно упростить, перейдя к 

эквивалентным фокусным расстояниям, вычисляемым с учётом кроп-фактора матрицы и 

используя оптимальные значения 
доп

p  : 

. 
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экв

ближн

f

Y

W

D
B  3,0 . 

Отношение 
экв

ближн

f

Y
 определяет масштаб ближнего плана съёмки. Если по замыслу съёмки 

желательно отодвинуть дальнюю границу стереоскопически передаваемого пространства, то 

можно одновременно увеличить фокусное расстояние эквf  и ближайшее отстояние 
ближн

Y . При 

этом масштаб ближнего плана и допустимое значение параллакса не изменятся, а большей длине 

фокусного расстояния будет соответствовать увеличенная глубина стереоскопически 

воспринимаемого пространства. 

В таблице 2.1 приведены рассчитанные значения длины базиса для стереосъёмки различных 

объектов с учётом просмотра стереопар на расстоянии наилучшего зрения (25 см). 

 

Таблица 2.1 

Рекомендуемые значения длины базиса стереосъёмки  

 Расстояние до объекта съёмки, м 

5 10 15 20 50 100 300 

Э
к
в
и

в
ал

ен
тн

о
е 

ф
о
к
у
сн

о
е 

р
ас

ст
о
я
н

и
е,

 

м
м

  

35 0,2 0,4 0,6 0,8 1,9 3,9 11,7 

50 0,1 0,2 0,4 0,5 1,3 2,7 8,2 

60 0,1 0,2 0,3 0,4 1,1 2,3 6,8 

80 0,1 0,1 0,2 0,3 0,8 1,7 5,1 

100 - 0,1 0,2 0,2 0,7 1,4 4,1 

150 - 0,1 0,1 0,2 0,4 0,9 2,7 

200 - - 0,1 0,1 0,3 0,7 2,0 

 

Наблюдение стереомоделей может осуществляться различными способами: с использованием 

стереоскопов (оптико-бинокулярный способ), стереоочков (анаглифических, поляризационных, 

светозатворных), а при некотором навыке и непосредственно, без использования специальных 

приспособлений («безочковый» способ). Метод наблюдения стереомодели с использованием 

анаглифических и светозатворных стереоочков предусматривает проецирование изображений 

левого и правого снимков стереопары на экран с наложением друг на друга (рис. 2.2). Точки, 

изображения которых оказываются полностью совмещёнными друг с другом (точка 2) 

воспринимаются находящимися в плоскости экрана (плоскости нулевых параллаксов). Если 

изображение точки на левом кадре на экране расположено левее соответственной точки на правом 

кадре, она будет восприниматься находящейся за плоскостью экрана (точка 1), если правее –  

перед экраном (точка 3). 
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Рис. 2.2. Принципиальная схема получения стереоскопической модели: а – положение точек в 

пространстве снимаемых объектов, б - положение точек на наблюдаемой стереоскопической 

модели. 

1 – точка на поверхности объекта; 1л, 1п – изображения точки 1 на левом и правом снимках 

стереопары; 1эл, 1эп – изображения точки 1 на экране (в плоскости нулевых параллаксов); 1
/ 

– 

изображение точки 1, воспринимаемое наблюдателем при стереоскопическом рассматривании 

стереомодели с использованием анаглифических, светозатворных  или поляризационных очков 
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Выбор параметров и правила выполнения стереоскопической фотосъёмки 

Масштаб наблюдения стереомодели, увеличение стереоизображения при просмотре влияет на 

выбор допустимых значений основных параметров стереосъёмки – расстояния до снимаемого 

объекта, стереобазиса, фокусного расстояния объектива. Поэтому стереосъёмка выполняется с 

расчётом на заранее определённые условия наблюдения. 

Расстояние до снимаемого объекта. Так как при стереосъёмке оба снимка должны иметь 

близкий масштаб, левая и правая точки съёмки в идеальном случае должны располагаться на 

одинаковом расстоянии от снимаемого объекта. 

Величина базиса стереосъёмки. Расстояние между левой и правой точками съёмки должно 

соответствовать заданной величине базиса стереосъёмки. Для расчёта длины базиса используют 

приведённые выше формулы. В полевых условиях удобнее производить расчёт по таблицам, 

предварительно составленным на основе этих формул. В случае, если определение точного 

значение фокусного расстояния затруднено, можно воспользоваться эмпирическим правилом: 

отношение величины базиса и расстояния до объекта должно находиться в пределах от 1:30 до 

1:50. Очевидно, чем дальше расположен объект, тем больше должна быть величина базиса. 

Положение базиса стереосъёмки. Чтобы избежать появления поперечного параллакса, 

вызванного смещением изображения соответственных точек друг относительно друга по оси y, 

положение базиса стереосъёмки в пространстве должно быть горизонтальным. Это значит, что 

камера во время съёмки с левой и правой точек должна располагаться на одной и той же высоте, 

которую можно отрегулировать высотой штатива. 

Ориентирование оптической оси объектива относительно линии горизонта. Оптические оси 

объективов, направленных на объект съёмки, должны быть строго горизонтальны или наклонены 

под одинаковым углом к линии горизонта. 

Ориентирование оптической оси объектива относительно направления базиса стереосъёмки. 

Оптические оси объективов могут располагаться перпендикулярно направлению базиса или под 

небольшим углом к нему (конвергентная съёмка). При использовании фотокамер любительского 

класса, не имеющих ориентирующих устройств, использование конвергентной съёмки позволяет 

упростить процесс ориентирования фотокамер, если при съёмке с левой и правой точек базиса в 

центре кадра будет располагаться одна и та же деталь фотографируемого объекта. Полученная 

стереопара снимков будет больше соответствовать особенностям стереозрения человека, для 

которого характерна конвергентность зрительных осей. 

Ориентация кадра по горизонтали или вертикали выбирается в соответствии с размерами 

объекта. Если размеры объекта позволяют, лучше выполнять съёмку при вертикальном положении 

кадра (формат «портрет»). При такой ориентации кадра достигаются наименьшие геометрические 

искажения в области перекрытия снимков и становится более комфортным наблюдение 
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стереомодели. Граница кадра должна быть параллельна линии горизонта, что позволит избежать 

разворота снимка. 

Область перекрытия снимков. Стереоскопическая фотосъёмка подразумевает получение с двух 

точек изображений одного и того же объекта. Чтобы обеспечить такие условия левый и правый 

снимки стереопары должны иметь максимально возможную область перекрытия (при 

конвергентной съёмке – практически 100%). 

При выборе фокусного расстояния следует помнить, что его увеличение способствует 

увеличению глубины стереоскопически воспринимаемого пространства. Использование короткого 

фокуса, наоборот, делает стереоскопическую модель более плоской и менее выразительной. 

Использование большего фокусного расстояния также уменьшает перспективные искажения по 

краям снимка. 

Условия освещения (время суток, соотношение прямого и рассеянного освещения, направление 

падения солнечных лучей относительно направления съёмки) выбираются так, чтобы  обеспечить 

наилучшее отображение форм рельефа. Левый и правый снимки стереопары могут быть получены 

как одновременно, например при использовании стереофотоаппарата с двумя объективами, так и 

последовательно. В последнем случае съёмку с левой и правой точек базиса следует выполнять 

при максимально близких условиях освещения, поскольку любое изменение светотени, смещение 

бликов и теней, зафиксированное на снимках, как правило, приводит к разрушению наблюдаемой 

стереомодели. Это условие накладывает ограничение и на использование поляризационного 

фильтра и фотовспышки. 

Параметры фотосъёмки следует подбирать с таким расчётом, чтобы добиться максимальной 

глубины резкости, поскольку рассматривание стереопар с малой глубиной резкости, когда глаз 

человека пытается сфокусироваться на изображении объекта, оказавшегося не в фокусе, вызывает 

ощущение сильного дискомфорта. Добиться максимальной глубины резкости можно за счёт 

минимально открытой диафрагмы. Однако следует иметь в виду, что неизбежное сильное 

увеличение выдержки, может привести к тому, что изображения на снимках стереопары могут 

различаться за счёт возможного перемещения фотографируемого объекта. Наблюдать 

стереоскопическую модель по таким снимкам не удастся. 

Все параметры съёмки, включая фокусное расстояние, и экспозиционные параметры должны 

оставаться неизменными при съёмке с левой и правой точек базиса. Это условие необходимо для 

достижения наибольшего подобия двух изображений. 

Использование дополнительного оборудования. Стереосъёмку для визуального 

стереонаблюдения можно проводить как со фотоштатива, так и без него.  Предпочтительнее 

съёмка со штатива с пузырьковым уровнем, так как в этом случае можно не только обеспечить 
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неподвижность фотоаппарата во время съёмки, но и более точно ориентировать его в 

пространстве. 

Компьютерная обработка снимков. Программное обеспечение 

Задача цифровой компьютерной обработки во время камерального этапа – подготовить 

стереопару для визуального наблюдения стереоскопической модели сфотографированного 

объекта, устранив возможные ошибки в ориентировании фотоаппарата во время съёмки и 

установив необходимое увеличение снимков. Для этого программным способом выполнятся 

взаимное ориентирование снимков стереопары, в результате которого исправляют искажения за 

счёт углов наклона, разворота снимков и сдвига относительно друг друга по вертикали (рис. 2.3). 

Таким образом, изображение цифровых снимков приближают к изображению, полученному 

при идеальных условиях съёмки. Затем можно приступать к наблюдению стереоскопической 

модели объекта на экране монитора различными способами, например: безочковым или с 

использованием анаглифических, поляризационных или светозатворных очков. 

Наиболее простой способ наблюдения – безочковый, он основан на раздельном рассматривании 

снимков стереопары без использования каких-либо приспособлений. Освоение такого способа 

требует тренировки и определённых усилий от наблюдателя. 

Анаглифический способ наблюдения стереомоделей основан на рассматривании 

анаглифических снимков через специальные анаглифические очки. Анаглифический снимок 

получается в результате совмещения в одном кадре левого и правого снимков стереопары, 

окрашенных в дополнительные цвета (например, красный и синий). Объёмное изображение 

возникает при рассматривании анаглифического снимка через очки с цветными светофильтрами 

соответствующих цветов. Красный светофильтр (левая линза в анаглифических очках) 

используется для рассматривания левого снимка, окрашенного в красный цвет, синий (правая 

линза) – правого, окрашенного в синий цвет. В настоящее время анаглифические снимки 

получают после компьютерных преобразований цифровых снимков. 

Подготовка снимков для визуального стереонаблюдения может выполняться как в свободно 

распространяемых специальных программах (Stereo Photo Maker), так и в некоторых 

универсальных графических редакторах  (Adobe Photoshop). 

Программа Stereo Photo Maker предназначена для взаимного ориентирования снимков в 

автоматическом или ручном режимах, а также для рассматривания стереоскопических снимков 

посредством специальных очков – поляризационных, затворных, анаглифических. Полученные 

снимки можно сохранять в собственном или в одном из универсальных форматов. 

В отсутствии специализированного программного обеспечения подобная задача может быть 

решена средствами распространенного графического редактора Adobe Photoshop. Программа 

Adobe Photoshop не содержит специальных  функций,  ориентированных  на  обработку  стереопар.  
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Рис. 2.3. Компьютерная обработка стереопары снимков. Получение 

анаглифических снимков 
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Однако арсенал средств обработки изображений, в том числе предназначенных для 

редактирования изображений по цветовым каналам, позволяет воспользоваться ими для взаимного 

ориентирования стереопар и создания анаглифических снимков. 

Порядок выполнения практической работы 

В задании предусмотрено получение стереопар двух объектов, ближний план которых 

располагается от точек съёмки на расстоянии соответственно порядка 10 и 100 м. В первом случае 

в качестве объекта рекомендуется выбрать форму микрорельефа или другой объект небольшого 

размера. Во втором – участок склона коренного берега и поймы реки с хорошо выраженными 

эрозионными формами. Для получения стереопар предусмотрен конвергентный способ съёмки, 

при котором направления оптических осей объектива сходятся в центральной точке снимаемого 

объекта. 

Подготовительный этап. Планирование съёмки 

На этапе планирования по картам или непосредственно на местности выбирают объект съёмки, 

определяют положение точек съёмки и расстояние до снимаемого объекта.  Исходя из 

планируемого способа наблюдения и масштаба будущей стереоскопической модели, 

рассчитывают значение базиса стереосъёмки, используя формулы расчёта базиса или  таблицы. 

Например, исходя из значений Y = 20 м, fэкв = 45 мм, W = 55 мм, D = 250 мм получают 

рекомендуемое значение длины базиса  

45

20

55

250
3,0 B   0,6 м. 

При съёмке нет необходимости точно придерживаться значения рассчитанной длины базиса. В 

приведённом примере хороший результат получится и при длине базиса около одного метра 

(рассчитанное значение ± 20%). 

Полевой этап. Получение стереопары снимков 

В полевых условиях выполняют стереоскопическое фотографирование. Основное внимание  

обращается на уточнение положения точек съёмки и расчётного значения базиса, правильное 

ориентирование фотокамер относительно линии горизонта и направления стереобазиса. В 

зависимости от условий освещения выбираются экспозиционные параметры. 

Стереоскопическая фотосъёмка объектов ближнего плана 

1. Исходя из условий освещения выбрать экспозиционные параметры съёмки. Менять 

установки при съёмке левого и правого снимков стереопары нельзя. Установить режим работы 

жидкокристаллического монитора фотоаппарата, при котором на нём изображается сетка 

вспомогательных линий. 

2. Рекомендуется сначала выполнить съёмку с левой точки базиса, затем – с правой. Это 

упростит поиск файлов с парными снимками при большом количестве отснятых стереопар. Так 
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как при расстоянии до снимаемого объекта порядка 10 м величина базиса съёмки составляет от 20 

до 30 см, фотографу нет необходимости перемещаться с одной точки съёмки на другую. 

Стереопара может быть получена путем перемены опорной ноги, когда фотограф, оставаясь на 

одной точке, левый снимок делает при опоре на левую ногу, а правый – при опоре на правую. 

Ноги должны находиться на ширине плеч, фотоаппарат на уровне глаз, локти плотно прижаты к 

груди, чтобы положение фотоаппарата было зафиксировано и менялось только из-за перемены 

опорной ноги, а не из-за дрожания рук. 

3. Учитывая, что стереопару рекомендуется снимать на вертикальный кадр, развернуть 

фотоаппарат. Меняя фокусное расстояние объектива, выбрать такой масштаб изображения, чтобы 

снимаемый объект занял около 2/3 кадра. 

4. Используя сетку вспомогательных линий на жидкокристаллическом мониторе выбрать 

границы кадра. Сохраняя по возможности горизонтальное положение оптической оси объектива, 

запомнить деталь объекта, находящуюся в центре кадра. 

5. Сделать левый снимок. 

6. Не опуская фотоаппарат, перенести тяжесть тела на правую ногу. При съёмке с правой точки 

стереобазиса проследить, чтобы центральная деталь объекта также находилась в центре правого 

кадра. 

7. Сделать правый снимок. 

8. Проконтролировать полученный результат, последовательно просмотрев на мониторе 

камеры левый и правый снимки полученной стереопары. Если съёмка выполнена правильно, при 

быстрой перемене левого и правого изображения возникнет впечатление «вращения» кадра вокруг 

его центральной точки. Если во время съёмки левого и правого кадров камера была наклонена под 

разным углом к горизонту или развернута вокруг оптической оси объектива, съёмку следует 

повторить до получения удовлетворительного результата. 

Стереоскопическая фотосъёмка объектов дальнего плана 

1. Уточнить экспозиционные параметры съёмки, если условия освещения поменялись. 

2. Для намеченного на этапе планирования участка склона коренного берега и поймы реки 

определить точное положение левой и правой точек съёмки, руководствуясь значением 

расстояния до ближнего плана (
ближн

Y  ~ 100 м) и рассчитанной ранее величиной базиса 

стереосъёмки (порядка трёх метров). По возможности выбрать для съёмки точки, находящиеся на 

одной высоте. 

3. Выполнить пробный просмотр выбранного участка в видоискатель или на мониторе 

фотоаппарата с предполагаемых левой и правой точек съёмки и убедиться, что в кадр не попадают 

объекты, расположенные ближе зоны оптимального восприятия стереоэффекта на стереомодели, 



 28 

например при съёмке противоположного берега реки – ветви деревьев в непосредственной 

близости от фотоаппарата. 

4. Если положение намеченных точек съёмки удовлетворительно, приступить к съёмке, 

начиная с левой точки. При использовании штатива выровнять его по пузырьковым уровням и 

сориентировать камеру на объект по сетке монитора. Выполнить съёмку. 

5. Повторить действия, перейдя на правую точку съёмки. Сориентировать камеру по сетке 

монитора так, чтобы в центре кадра оказался тот же объект, что и при съёмке с левой точки 

базиса. 

6. Так же, как и при съёмке объекта ближнего плана, оценить качество полученной стереопары. 

Камеральный этап. Компьютерная обработка снимков 

На этапе камеральных работ выполняют взаимное ориентирование снимков стереопары, 

подготавливают стереопару для безочкового и анаглифического способов стереонаблюдения. 

Выполнение компьютерной обработки снимков предусматривается средствами программ 

Stereo Photo Maker  или Adobe Photoshop. 

Порядок выполнения работы в программе Stereo Photo Maker 

1. Открыть в окне просмотра левый и правый снимки (кнопка в горизонтальном меню Open 

left/Right Images или пункт меню File→Open left/Right Images). При открытии пометить галочкой 

опцию Show Preview. Выбрать сначала левый (OK), потом правый (OK) снимки стереопары. После 

этого оба снимка выведутся на экран одновременно. При необходимости развернуть снимки, 

поменяв ориентацию «портрет» на «ландшафт» или наоборот (пункт меню Edit →Rotate/Flip 

Image). 

2. Выполнить взаимное ориентирование снимков в автоматическом режиме (кнопка Auto 

Alignment или пункт меню Adjust→Auto Alignment), в ходе которого цифровые снимки будут 

трансформированы для устранения последствий разворота камеры и перспективных искажений, 

вызванных ее наклоном. После выполнения операции закрыть информационное окно Auto aligment 

values с результатами ориентирования.  

3. Получить анаглифический снимок, нажав кнопки GrayAnaglif (вариант светофильтров 

red/cian) или ColorAnaglif (вариант светофильтров color(red/cian)). На экране появится 

анаглифический снимок. Для наблюдения стереоскопической модели надеть анаглифические очки 

так, чтобы красный фильтр был слева. Для изменения масштаба изображения можно использовать 

колесо мыши. Если наблюдается обратная стереомодель, поменять местами левый и правый 

снимки (кнопка Swap left/Right или пункт меню View→Swap left/Right).  

4. При необходимости улучшить визуальное восприятие стереоскопической модели, 

скорректировав взаимное ориентирования снимков в ручном режиме (кнопка Easy Adjustment или 

пункт меню Adjust→Easy Adjustment). Используя возможность разворота и смещения снимков по 
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горизонтали и вертикали, добиться совмещения в кадре изображений левого и правого снимков 

для наиболее комфортного наблюдения стереомодели. Сохранить результат, нажав кнопку ОК. 

Если улучшить восприятие стереомодели не удаётся, не сохраняя результатов, кнопкой Сancel 

закрыть окно Easy Adjustment.  

5. Сохранить сориентированную стереопару (кнопка Save Left/Right Images или пункт меню 

File→ Save Left/Right Images). Если необходимо, обрезать края анаглифического снимка (кнопка 

Free Cropping). Сохранить полученный результат в виде анаглифического снимка (кнопка Save  

Stereoimage или пункт меню File→ Save  Stereo Image). 

Порядок выполнения работы в программе Adobe Photoshop 

1. Открыть левый и правый  снимки стереопары. 

2. Открыть окно управления цветовыми каналами (Window→Channels). 

3. Перейти к обработке правого снимка. В окне управления цветовыми каналами выделить 

красный канал (Channels канал RED). При этом все каналы, кроме красного станут невидимыми.  

4. Сделать активным окно с изображением правого снимка. Выделить (Select→All) и удалить 

(клавиша Del) изображение правого снимка в красном канале, не удаляя сам канал. 

5. Перейти к обработке левого снимка. Выделить в нём красный канал (Channels). 

6. Выделить (Select→All) и скопировать (Еdit→Copy) изображение левого снимка в красном 

канале. 

7. Вернуться к обработке правого снимка и переместить в красный канал выделенное 

изображение левого снимка (Edit→Paste при активном красном канале RED). 

8. Сделать видимыми все каналы правого снимка (курсором включить Indicatesc Channel 

visibility в окне Channels), не помечая сами каналы. На экране одновременно появятся 

изображения левого и правого снимков, сдвинутые и развёрнутые относительно друг друга. 

9. Надеть анаглифические очки. Выполнить совмещение изображений левого и правого 

снимков до появления стереомодели. Для этого инструментом Move Tool (v) (стрелка при нажатой 

левой кнопке мыши) или стрелок клавиатуры переместить изображение левого снимка в красном 

канале до совмещения с контурами правого снимка в синем канале. Перемещением в направлении 

верх-низ устранить вертикальный параллакс. Перемещением в направлении лево-право 

совместить стереопарные детали, относящиеся к выбранной начальной плоскости стереомодели 

(плоскости нулевых параллаксов). При необходимости развернуть изображения или выполнить 

другие операции, связанные с трансформированием снимков (Edit→Free Transorm). После этих 

операций на экране будет наблюдаться совмещенное изображение левого и правого снимков. 

Обрезать края полученного анаглифического снимка и сохранить его. 
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Подготовка снимков к отчёту 

В программе Adobe Photoshop создать новый документ А4 и перенести в него стереопары, 

полученные для объектов ближнего и дальнего планов, предварительно обработанные в 

программах Adobe Photoshop или Stereo Photo Maker. Каждая стереопара представляется в двух 

вариантах: в виде стереопары снимков, подготовленных для наблюдения безочковым способом, и 

в виде анаглифических снимков. 

Стереопары для наблюдения безочковым способом должны иметь размер, который обеспечил 

бы комфортные условия наблюдения на расстоянии наилучшего зрения (25 см). Для этого левый и 

правый снимки нужно разместить рядом по одной линии, уменьшив их до такого размера, чтобы 

расстояние между соответственными точками объектов ближнего плана на левом и правом 

снимках составляло около 55 мм (рис. 2.4). 

Контрольные вопросы 

1. В какой зависимости находится базис стереосъёмки от расстояния до объекта? 

2. Какой приём можно использовать для правильного ориентирования фотоаппарата при 

конвергентной стереосъёмке? 

3. Можно ли менять установки фотоаппарата при съёмке с левой и правой точек базиса 

стереосъёмки? 

4. Какими должны быть условия освещения объекта при стереосъёмке? 

5. Каким должно быть перекрытие снимков стереопары при конвергентной съёмке? 

6. Сформулируйте суть способа получения анаглифических снимков. 

Отчётный материал 

1. Две стереопары снимков, полученные при съёмке объекта ближнего и дальнего планов. 

2. Два анаглифических снимка объектов ближнего и дальнего планов. 

3. Распечатка анаглифических снимков и стереопар, подготовленных для безочкового 

наблюдения, оформленная в соответствии с образцом.   

4. Ответы на контрольные вопросы. 
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Рис. 2.4. Пример оформления отчётного материала 
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3. Фотосъёмка с близкого расстояния (макросъёмка) 

 

Цель работы 

Освоение основных приёмов макросъёмки, получение навыков макросъёмки при проведении 

полевых геоботанических исследований. Знакомство со способами компьютерной обработки 

цифровых макроснимков для улучшения качества  изображения. 

Назначение фотосъёмки с близкого расстояния (макросъёмки). Возможные области 

применения в географии 

Съёмка с близкого расстояния, или макросъёмка предназначена для получения изображений 

объектов в масштабе 1:1 и крупнее. В названии отражена главная особенность съёмки, которая 

выполняется с расстояний минимальной дистанции фокусировки и меньше. 

При полевых географических исследованиях макросъёмку применяют, чтобы получить 

изображение мельчайших деталей объекта, неразличимых при рассматривании невооружённым 

глазом, например, если необходимо зафиксировать структуру почвенного разреза с характерными 

включениями, особенности отдельных частей растения, следы патогенных изменений листьев и 

т. д. На полевой общегеографической практике первого курса макросъёмка может быть особенно 

полезна во время прохождения практик по географии почв и ботанической географии. 

Используемое оборудование 

Для макросъёмки можно использовать практически любую цифровую камеру. Большинство из 

них имеют специальный режим «Макро», облегчающий получение макроснимков приемлемого 

качества. Одним из показателей качества макроснимков является их масштаб, который зависит от 

фокусного расстояния объектива и минимальной дистанции фокусировки. Чтобы получить 

снимки максимально крупного масштаба, выбирают фотоаппараты с наименьшим значением 

минимальной дистанции фокусировки и специальными макрообъективами. 

Масштаб полученного изображения можно увеличить, применив макролинзы или 

удлинительные кольца. Макролинзы подобно лупе приближают изображение к объективу. К 

преимуществам макролинз, накручивающихся на объектив, можно отнести возможность 

выполнять макросъёмку фотоаппаратом с несменяемой оптикой, к недостаткам – снижение 

резкости по краям кадра. Удлинительные кольца устанавливают между объективом и корпусом 

фотокамеры со сменяемыми объективами. Масштаб макроснимков будет укрупнён, но при этом 

объектив не сможет фокусироваться на бесконечность. 

К оборудованию, необходимому для улучшения качества макроснимков следует отнести также 

штатив для фиксации фотоаппарата в момент съёмки, пульт дистанционного управления кнопкой 

спуска, фокусировочные рельсы для плавного изменения расстояния до объекта и источники 
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дополнительного освещения: различные виды вспышек, подсветок, рассеивающие экраны для 

улучшения освещённости объекта съёмки. 

Теоретическое обоснование 

Чтобы понять особенности получения изображения при макросъёмке, необходимо  вспомнить 

некоторые положения оптики. Хотя объектив и является сложно устроенной системой линз, 

проиллюстрировать принцип его работы можно на примере закона формирования изображений 

тонкой линзой.  Из оптики известно, если снимаемый объект находится на бесконечно удалённом 

расстоянии от линзы, то его изображение будет сформировано линзой в фокальной плоскости. Эта 

зависимость отражена в формуле линзы 

1/а + 1/b = 1/f  , 

где a – расстояние от оптической плоскости линзы до объекта; b – расстояние от оптической 

плоскости до изображения;  f – главное фокусное расстояние линзы. Линейное увеличение тонкой 

линзы рассчитывается как 

М = b/a . 

Если объект находится в интервале между фокусным и двойным фокусным расстоянием, то его 

изображение будет иметь масштаб 1:1 и крупнее (рис. 3.1). Известно также, что масштаб 

изображения увеличивается при увеличении фокусного расстояния. Поэтому при макросъёмке 

выбирают максимальное фокусное расстояние объектива и приближают объектив к объекту 

съёмки на минимально возможное расстояние – минимальную дистанцию фокусировки.  

Важным показателем при макросъёмке 

является глубина резкости изображения – 

ширина зоны пространства изображения, в 

пределах которой изображение объекта 

воспроизводится с допустимой резкостью. 

Соответствующий ей интервал расстояний от 

объектива до объекта съёмки называется 

глубиной резко изображаемого пространства 

(ГРИП). По мере уменьшения дистанции до 

снимаемого объекта и увеличения фокусного 

расстояния величина ГРИП уменьшается. Для макросъёмки она составляет порядка нескольких 

сантиметров. Объекты, находившиеся в момент съёмки чуть ближе или дальше от дистанции 

фокусировки, изобразятся на снимке нерезко. Иногда, в художественной фотографии таким 

приёмом пользуются для того, чтобы подчеркнуть, выделить деталь объекта, создавая вокруг нее 

нерезким изображением своеобразный художественный фон. Однако при макросъёмке в научно-

Рис. 3.1. Принципиальная схема макросъёмки 
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исследовательских целях чаще требуется получить изображение с большей глубиной резкости, с 

хорошо проработанными деталями всего объекта. 

Основным средством увеличения глубины резкости является применение при съёмке 

максимально закрытой диафрагмы, то есть минимального диаметра действующего отверстия. 

Благодаря этому оптическое изображение формируется лучами, проходящими только через 

центральную часть объектива и, тем самым, устраняются искажения, вносимые его краевой 

частью. Размер диаметра действующего отверстия регулируется выбором диафрагменного числа. 

Чем больше диафрагменное число, тем меньше диаметр отверстия диафрагмы. Следовательно, для 

получения изображений с большей глубиной резкости необходимо выбирать большие значения 

диафрагменных чисел. 

Так как при максимально закрытой диафрагме уменьшается поток света, поступающего на 

матрицу, для установки оптимальной величины экспозиции требуется увеличение времени 

воздействия света на матрицу за счёт большего времени выдержки. Такой способ оптимизации 

экспозиции оправдан при съёмке неподвижных объектов. Но при макросъёмке на природе, когда 

фотографируемые объекты – насекомые или колышущиеся на ветру растения, – как правило, 

находятся в движении, увеличение выдержки может привести к ухудшению качества изображения 

в результате смаза. Чтобы сократить время выдержки, сохраняя минимальный диаметр 

действующего отверстия диафрагмы, повышают освещённость объекта съёмки. Для этого 

используют дополнительные источники освещения: вспышки, ламповые и светодиодные 

осветители, а при солнечной погоде – отражатели света. В любом случае при выборе 

экспозиционных параметров следует соблюдать баланс между выдержкой и диафрагмой. 

 Причиной смаза изображения может быть не только движение объект, но и неустойчивость 

фотоаппарата в момент съёмки. Повысить его устойчивость можно, зафиксировав фотоаппарат на 

штативе и используя спусковой тросик, пульт дистанционного управления или задержку спуска, 

которые предотвратят сдвиг фотоаппарата при нажатии кнопки спуска. 

Выбор параметров и правила выполнения макросъёмки 

Выбор точки съёмки. Главным критерием при выборе точки на природе – возможность 

приблизить объектив к нужной детали объекта так, чтобы обеспечить максимальный масштаб 

изображения и хорошее освещение объекта, не закрыв его тенью от фотоаппарата. 

Требуемый масштаб изображения достигается выбором соотношения между фокусным 

расстоянием и величиной дистанции фокусировки. Уменьшать дистанцию фокусировки, как и 

увеличивать фокусное расстояние можно в определённых пределах. Отношение максимального и 

минимального значений главного фокусного расстояния для каждого фотоаппарата указывается на 

оправе объектива в виде кратности увеличения. Эта величина показывает, во сколько раз может 

измениться масштаб оптического изображения, формируемого объективом на поверхности 
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матрицы при крайних значениях фокусного расстояния. В цифровых фотоаппаратах существует 

возможность увеличения изображения, зафиксированного матрицей, программным способом, за 

счёт увеличения центральной части спроецированного изображения до размеров всей матрицы. 

Кратность такого увеличения указывается в виде «цифрового увеличения». Цифровое увеличение 

не приводит к увеличению детальности изображения и глубины резкости, и его использование при 

макросъёмке не рекомендуется. 

Расстояние до снимаемого объекта при макросъёмке стремятся сделать минимальным для 

получения максимально крупного масштаба изображения. Технически расстояние ограничивается 

размером минимальной дистанции фокусировки и может быть сокращено при использовании 

макролинз. Регулировать расстояние до объекта при макросъёмке можно используя 

фокусировочные рельсы – специальное приспособление для плавного перемещения на 

микрорасстояния зафиксированного на них фотоаппарата. Фокусировочные рельсы требуются при 

получении серии снимков одного объекта с фокусировкой на его части по-разному удалённые от 

объектива. Полученную таким образом серию снимков используют для «стекинга» – создания из 

нескольких снимков одного изображения с повышенной глубиной резкости.  

Для построения композиции кадра при съёмке в режиме «Макро» лучше пользоваться 

монитором фотоаппарата. Поможет он и при контроле за глубиной резкости изображения. 

Видоискатель для выбора композиции используют только при съёмке зеркальным фотоаппаратом, 

в котором изображение в видоискателе создается съёмочным объективом и полностью 

соответствует будущему кадру. 

Условия освещения должны обеспечить максимальную освещённость объекта. Полуденное 

Солнце при безоблачной погоде создаёт наилучшие условия по общей освещённости, но 

одновременно усиливает контрасты между освещёнными и затенёнными участками. В этом случае 

для равномерного освещения всех деталей объекта рекомендуется использовать дополнительную 

подсветку теней рассеивающими экранами и зеркалами. Рассеянный свет в условиях сплошной 

облачности создаёт более равномерное освещение, но может оказаться недостаточным. Такие 

макроснимки получаются менее выразительными. Недостаточное рассеянное освещение можно 

компенсировать вспышкой. Использование встроенной фотовспышки с жёстким направленным 

светом, как правило, оказывается неэффективным. Такая вспышка создаёт блики на блестящих 

поверхностях и резкие тени на неосвещённых участках. Лучший результат можно получить при 

вспышке с рассеивателем, создающим более равномерное освещение. 

Выбор режима съёмки. Съёмку с близкого расстояния можно выполнять как в ручном режиме, 

когда все параметры съёмки задаются фотографом, а фокусировка выполняется вручную, так и в 

специальном режиме «Макро», который имеется в большинстве цифровых фотоаппаратов и 

предусматривает автоматическую фокусировку. 
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Выбор экспозиционных параметров при равных условиях освещения зависит от типа 

снимаемого объекта. Неподвижные объекты, например кору деревьев, мох, лишайники, другие 

растения в условиях полного безветрия можно фотографировать при больших значениях 

выдержек. В этом случае появляется возможность повысить глубину резкости за счёт уменьшения 

действующего отверстия диафрагмы, которое достигается выбором максимальных значений 

диафрагменных чисел. При съёмке движущихся объектов (колышущиеся растения или 

движущиеся насекомые) приходится жертвовать глубиной резкости, уменьшая время выдержки и 

увеличивая диаметр действующего отверстия, чтобы снизить риск смаза изображения.  

Выбор режима и зоны фокусировки. В современных фотоаппаратах используется как ручная, 

так и автоматическая фокусировка. При съёмке растений и насекомых между объективом и 

объектом съёмки часто могут располагаться другие объекты – травинки, веточки других растений. 

Использование автофокусировки может привести к тому, что объектив сфокусируется не на 

выбранный для съёмки, а на ближайший к объективу объект. В таких случаях рекомендуется 

использовать режим ручной фокусировки или режим фиксации фокусировки. Если пространство 

между объектом съёмки и объективом свободно, можно использовать режим автофокусировки. 

Получить более или менее удовлетворительный результат можно, выбрав центральную зону 

фокусировки, когда фокусировка автоматически выполняется по объекту, находящемуся в центре 

кадра, или режим произвольного выбора положения точки фокусировки. Последнее бывает важно, 

если фокусировку планируют выполнить по объекту, находящемуся на краю кадра. 

При съёмке неподвижных объектов можно использовать режим с фокусировочной вилкой, 

часто именуемый фокус-брекетингом, в котором камера автоматически снимает три кадра: один с 

ручной настройкой фокусировки и по одному с более далёкой и более близкой фокусировкой. 

Компьютерное совмещение может использоваться для получения одного изображения с большой 

глубиной резкости. Чтобы обеспечить неподвижность не только фотографируемого объекта, но и 

фотоаппарата, такая съёмка должна выполняться строго со штатива. 

Перед началом съёмки рекомендуется выбрать максимальное разрешение и минимальный 

уровень сжатия при записи снимка. При таких параметрах объём файлов цифровых снимков 

получится большим, но будет достигнута максимально возможная детальность и наилучшая 

передача цветов и локальных контрастов изображения. 

Компьютерная обработка снимков. Программное обеспечение  

Задача цифровой компьютерной обработки – повысить качество изображения макроснимка, 

устранив геометрические искажения и улучшив его цветовые и контрастные характеристики. 

Компьютерную обработку можно выполнить средствами любых графических редакторов, среди 

которых наибольший интерес может представлять отличающийся широким набором функций 

Adobe Photoshop (рис. 3.2). 
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Рис. 3.2. Компьютерная обработка макроснимков 
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Коррекция баланса белого. Потребность в такой коррекции может возникнуть, если съёмка 

проводилась при смешанном освещении, от основного источника света и дополнительной 

подсветки. 

Улучшение цветопередачи выполняют, если коррекция баланса белого не даёт нужного 

результата. Тогда при коррекции цветовых составляющих опираются на субъективные ощущения 

исполнителя и цветопередачу используемого монитора. 

Расширение тонового диапазона применяется, если фотосъёмка велась в условиях 

недостаточной освещённости. 

Улучшение резкости изображения. Если по каким-то причинам, например из-за смаза или 

неудачной фокусировки, получают недостаточно резкие, размытые изображения, создать 

визуальный эффект более резкого изображения можно путём искусственного повышения 

локальных контрастов. В Adobe Photoshop для такого преобразования можно использовать 

фильтры «Sharpen». 

Увеличение глубины резкости. Получить изображение с большой глубиной резкости, 

охватывающей практически весь объект макросъёмки можно в результате процедуры стекинга – 

программного соединения в один кадр нескольких снимков одного объекта с разными зонами 

резкости изображения. 

Все указанные выше преобразования можно выполнить как для всего снимка, так и для его 

отдельных частей, используя для этого режим быстрой маски. 

Кадрирование изображения. На заключительном этапе обработки выполняют кадрирование 

изображения, которое помогает исправить неудачную композицию, отсечь детали, мешающие 

сконцентрировать внимание на объекте съёмки. Кадрированием можно выбрать интересующую 

часть изображения объекта и затем сохранить её в виде нового снимка (для удобства просмотра с 

увеличением). 

Порядок выполнения практической работы 

Практическая работа предусматривает получение нескольких макроснимков 

удовлетворительного качества с изображением различных растений, насекомых или других 

природных объектов, полученных при разных значениях диафрагменных чисел с использованием 

штатива и без него. 

Подготовительный этап. Планирование съёмки 

На этапе планирования выполняется подготовка дополнительного оборудования для 

макросъёмки: штативов, вспышек, осветителей и отражателей. С учётом особенностей снимаемых 

объектов выбираются подходящие погодные условия и время суток. Дождливая и ветреная погода 

исключаются. При планировании начала работ делается поправка на время, которое неизбежно 

приходится потратить на поиск намеченных к съёмке объектов. 
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Для освоения и отработки приёмов макросъёмки необходимо выбрать благоприятные условия 

для выполнения  задания: солнечную безветренную погоду и время дня, близкое к полудню. 

Полевой этап. Получение макроснимков 

Во время съёмки выбирается режим съёмки («Макро» или ручной режим) и другие установки 

фотоаппарата (баланс белого, режим фокусировки и др.), оптимальное положение фотоаппарата и 

выполняется съёмка.  

1. Выполнить со штатива макросъёмку неподвижных природных объектов: коры деревьев, 

участков мха и лишайников. 

2. Выбрать точку съёмки, установив штатив так, чтобы объектив закреплённого на нём 

фотоаппарата располагался от объекта на расстоянии нескольких сантиметров (не более 5–7). 

Позиция для съёмки должна удовлетворять требованиям наилучших условий освещения. При 

необходимости подсветить затенённые участки объекта. 

3. В соответствии с условиями освещения задать экспозиционные параметры в режиме 

«Приоритет диафрагмы», установив минимальное значение диафрагменного числа. Правильная 

экспозиция и выдержка будут установлены фотоаппаратом автоматически. 

4. Для фокусировки выбрать режим «автофокусировка», и «центральная зона фокусировки». 

5. Выбрать режим «Макро». 

6. Наблюдая изображение на мониторе фотоаппарата, уточнить композицию кадра с учётом 

того, что зона фокусировки и, следовательно, интересующий фрагмент объекта будут находиться 

в центре кадра. 

7. Нажав наполовину кнопку спуска, выполнить фокусировку на объект в центре кадра. Не 

отпуская кнопку, дождаться, когда произойдёт автоматическая фокусировка и изображение на 

экране станет резким, после этого нажать кнопку до конца. 

8. Проверить полученный результат, просмотрев его на экране монитора. При необходимости 

повторить съёмку при тех же параметрах до получения удовлетворительного результата. 

9. Повторить съёмку, установив максимальное значение диафрагменного числа. Просмотреть 

на мониторе и сравнить изображения, полученные при минимальном и максимальном значениях 

диафрагменных чисел. 

10. Повторить съёмку этого же объекта в режиме фокусировки на произвольную точку 

«FlexiZone» и в ручном режиме. 

11. Выполнить макросъёмку без штатива слабо подвижных природных объектов (улиток, 

гусениц и т.д.), выбрав минимальное, а затем максимальное значение диафрагменного числа и 

используя остальные параметры фотосъёмки, при которых ранее были получены наилучшие 

результаты. 
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12. Выполнить макросъёмку цветущего растения на выбор с рук или со штатива, выбрав 

минимальное, а затем максимальное значение диафрагменного числа и используя остальные 

параметры фотосъёмки, при которых ранее были получены наилучшие результаты. 

Камеральный этап 

Компьютерная обработка снимков направлена на яркостную и геометрическую коррекцию 

снимков, а также, в случае необходимости, на повышение резкости изображения. 

Порядок выполнения работы в программе Adobe Photoshop 

1. В программе Adobe Photoshop открыть несколько вариантов макроснимков, полученных для 

разных типов объектов и при разных значениях диафрагменных чисел. 

2. Выбрать лучшие пары снимков объектов трех типов, полученные при минимальном и 

максимальном значении диафрагменных чисел. Оценить разницу в глубине резкости изображения 

на этих снимках. 

3. При необходимости выполнить расширение тонового диапазона и повышение резкости 

изображения. Кадрировать снимки, выделив на них фрагменты, отличающиеся наиболее резким 

изображением. Сохранить кадрированные снимки с новыми именами. 

Подготовка снимков к отчёту 

Для подготовки снимков к отчёту в программе Adobe Photoshop создать новый документ А4 и 

перенести в него изображение отобранных и обработанных макроснимков. Для каждого снимка 

привести значения фокусного расстояния, выдержки и диафрагменного числа, указанные в 

метаданных соответствующих исходных снимков (рис. 3.3), а также условия выполнения снимков 

(со штатива или без него). 

Контрольные вопросы  

1. Каким должно быть расстояние до снимаемого объекта при макросъёмке? 

2. Какие установки фотоаппарата повышают глубину резко изображаемого пространства? 

3. Какие погодные условия неблагоприятны для выполнения макросъёмки на местности? 

4. Какое дополнительное оборудование используют при макросъёмке? 

5. Назовите виды компьютерных преобразований, используемых для повышения качества 

макроснимков. 

Отчётный материал 

1. Несколько макроснимков хорошего качества. 

2. Цифровые макроснимки после компьютерной обработки. 

3. Распечатка макроснимков, полученных при разных значениях диафрагменных чисел, 

оформленных в соответствии с образцом. 

4. Ответы на контрольные вопросы. 
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Рис. 3.3. Пример оформления отчётного материала 
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